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Introduction:

MailSteward ™

Safely archive thousands of emails

Access your email with all the power of a relational database

Have you ever wished you could find all those emails between you and your client, Joe, during
August and September of last year, that mention the word 'contract'? Now you can. And you can
sort them, print them, save them, and export them in several standard formats. MailSteward
elegantly solves your email archiving, accessing, and management problems.

Email clients, like Postbox and the Apple OS X Mail application, are very good at sending and
receiving email, and doing simple searches, but they are not really designed to efficiently and
safely archive and access tens of thousands of emails.

Email has become a vital part of many professional and personal lives. For many, it is not
unusual to send and receive thousands of emails every month. Businesses and individuals with
large amounts of important email need to be able to:

e safely archive email text and attachments so that none of it is ever lost.

e casily and effectively find particular emails, by any combination of sender, recipient, date
range, keywords, and tags.

e export email in standard formats to prevent data obsolescence.
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The first time you launch MailSteward, this is what you will see:

Print V] Save V| Delete v Create a new database file: New ) Fwd 0 Tag Raw
1 I
ID  ATCH DATE TIME T MAILBOX
Open an existing database file: Open
Quit
*has tag 2

To get started, create a new database file. Locate and name the file however you wish. By default
MailSteward will automatically select all of your Apple OS X Mail application email accounts to
be archived. If you are a Postbox user instead, you will need to go to the Settings to switch from

Apple Mail to Postbox.. Then all you have to do is click on the archive button, and MailSteward
will begin copying your email into the database file that you have created.

Any of the settings can be changed by clicking on the settings button. The database file is a
single file, like any other file, and can be named anything, and located anywhere, and you can
copy it or move it or rename it at any time.

You don't have to worry about doing anything to your email files. They are left untouched.

You don't have to worry about duplicates. If an email is already in the database and you archive it
again, MailSteward will skip it rather than add a new entry.
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Once they have all been copied into the database, you can delete all or most of the email from
your In and Sent boxes, if you wish. MailSteward will archive the attachments, HTML, enriched
text, and the original raw source of your email, as well as the plain text.

Then, whenever you need to find an email, you can use MailSteward.

Once your email is in a database, it can be retrieved by clicking on the search button and
specifying any combination of:

e Arange of beginning and ending dates.

e keywords or phrases in the From address.

e keywords or phrases in the To address.

e keywords or phrases in the Subject line.

e keywords or phrases in the Body text.

e text strings in the Mailbox name.

e text strings in an attachment file name.

e Text inside attachments that contain text.

e Tags - category, keywords, notes, and/or priority.

Or, if you know SQL, by editing the generated SQL statement.

And you can sort the retrieved emails by:

e Date

e From

e To

e Subject
e Mailbox

e Or by the unique ID that is assigned to each email

Features:

e Works seamlessly with Postbox or the Mac OS X Mail application to archive all your
email in a relational database.

e Will import most "mbox" format files from other email clients such as Microsoft
Entourage X and Outlook.

e Works with all locally stored POP, .Mac, and IMAP email accounts.

e Select emails from archive by date range and keywords in the To, From, Subject,
Mailbox, or Body fields.

e Sort by date, To, From, Subject, or unique ID.

e Print email list, or individual email, or all emails in a list.

e Save emalil list, or individual email, or all emails to a text file.

e Save all attachments of selected emails to separate files.

e Reply to or forward individual emails.

e Add your own tags to email & import MailTags©.

e Search attachments, such as word processing documents, that contain any text.
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e Schedule MailSteward to archive your email automatically.

e Export emails to a tab-delimited text file, a new MailSteward database file, an mbox file,
or an SQL file.

e Merge database files together.

e All Mail or Postbox email and folders are left undisturbed.

e Options to store all attachments, attachments less than a given size, or no attachments.

e Native Cocoa application that supports OS X 10.6 or greater (Snow Leopard, Lion,
Mountain Lion, & Mavericks)

e The free version of MailSteward has full functionality, but is limited to a capacity of
15,000 emails.

MailTags is Copyright © Scott Morrison.
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Settings:

Clicking on Settings brings up the Settings window. When you first launch MailSteward the
default Settings are in place. If you click on Archive, MailSteward will archive the email in all of
the email accounts that you have in the OS X Mail application, into the database file that you
have created. If you are using the Postbox email application instead of Apple Mail, click on the
Postbox button and Save Settings. There are also default settings for a number of other options.

Settings are associated with database files. Each database file, if you have more than one, has its
own settings. There are several different panels in the Settings window, which are described
below. When any of the Settings have been changed, click on the Save Settings button to save the
changes. You can also reset all of the Settings back to the defaults by clicking on the Reset
button.

The General Settings panel is where you can choose between the Apple Mail and Postbox email
clients, and where you can open an existing database file, or create a new one, by clicking on the
Open or New buttons.

Choose your email application

¢ Apple Mail Postbox None

Database File Path:
/Volumes/Macintosh HD2/mymaildb

Include Trash mailboxes
Include Junk mailboxes
Do not skip duplicates when archiving

Don't store attachments larger than

v Limit search results to 1000 emails

Always launch attachments when clicked
v Check for updates on launch

Save Settings
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The path and file name of the current database file is shown in the text box. There is an option to
limit the size of archived attachments to some number of megabytes. There are also options to
specify whether or not to include Trash and Junk mailboxes, and all mailboxes. Duplicate emails
that are already in the database are skipped when archiving. If you don't wish to skip duplicates,
you can check the box that says, "Do not skip duplicates when archiving". You can also choose
to set an upper limit on the number of emails retrieved by searching or browsing, and you can
choose to always launch attachments when they are clicked on instead of being asked whether to
launch them or save them as files. By default, MailSteward will automatically check for new
versions. If you don't want this you can uncheck the 'Check for updates on launch' box, and you
can always check for updates by choosing 'Check for Updates...' from the MailSteward menu.

[ ) ‘ Accounts
1@ oo 0O (2
General nts Viewing Scheduling Tag Rules

bugs@diskrefresher.com
bugs@mailsteward.com
bugs@pixsteward.com
comcast
features@diskrefresher.com
features@pixsteward.com
filemyfiles bugs
filemyfiles features
gateway@pubblog.com
Gmail

Google

iCloud

(
s
[.

T Gnoose. |
[ ]

Save Settings

The Accounts panel allows you to select the email accounts or mailboxes that you wish to
archive. By default all email accounts are selected. You can choose whether to select accounts or
select mailboxes. You select an account or mailbox by clicking on the check box next to it.

You can also tell MailSteward to always archive any email mbox files that are in a particular
folder. MailSteward will then look for email files in the specified folder and all of its subfolders
and archive them in addition to the email in the selected accounts or mailboxes. If the box is
checked to "Delete email in this import folder after it is archived", then the email files in the
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designated folder will be deleted once they have been archived. However, MailSteward does not
ever delete email from the Apple Mail or Postbox accounts.

The Viewing panel lets you set the font and the date format to be used when displaying email
text. Any combination of year, month, day order and separator character (-, /, .) can be chosen for
the date format. You can also choose the default sorting order for Browse and Search results.
Choose any of the fields to sort by, and whether the sort should be ascending or descending.

oo Viewing
a8

Set List Text Font... Set Body Text Font...

Save Settings

The Scheduling and Tag Rules Settings are explained in separate sections of this manual,
Schedule Archive and Set Rules for Tagging.
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Archive Email:

Clicking on the Archive button will bring up this sheet:

@ done retrieving email from /Users/jns/Desktop/junkdb
Print ¥ Save ¥ Delete v Exp Archive email beginning on this date: leply | Fwd =[S Tag ) Raw
1 month day year E
ID ATCH DATE TIME WECT MAILBOX
- B s B oo B 205 B :
10580 0 2015-05-01 09:53:06 ment, March ImapMail/mail.mailstewa
6697 0 2015-04-30 10:45:06 ) ) st know this? ImapMail/host208.hostr
6679 0 2015-04-30 10:45:06 And/or ending on this date: ineration ImapMail/host208.hostrr
6379 0 2015-04-30 10:44:40 month day year tification: PUB ImapMail/host208.host
378 ) 1 30 4 3 < o t ati [ / t I r
6378 0 2015-04-30 10:44:40 Al u I - B “ tification: PUB ImapMail/host208.hoster
5448 0 2015-04-30 10:43:46 wir Brand Ider ImapMail/host208.hostmr
5263 0 2015-04-30 10:43:37 Reset All tification: JOH ImapMail/host208.hoster
361 0 2015-04-30 10:35:26 /e happiness ImapMail/mail.mailstewa
1141 0 2015-04-26 15:33:29 - < hrouch orod: ImanMail/mail. mailstewa
| Cancel Archiv |
o
“has tag The 200 most recent emails. s

MailSteward will automatically set the beginning date to the date of the most recent email
archived in the database. Any email prior to that date will be skipped. This will save time if you
have already processed email prior to a given date. Or you can set the date to "All" for month,
day, and year, and MailSteward will process all of the email in your account(s). You can also set
an ending date. This can be useful if you want to, for example, just store all of the email prior to
2004. Clicking on the Reset All button will reset the beginning and ending dates to "All".

Once you have chosen a beginning date and/or ending date, and clicked on the Archive button,
MailSteward will begin processing your locally stored email and archiving it into the database. If
you have a .mac or other imap account, you must set the account options to keep copies of your
email on your local computer. MailSteward does not access email on remote servers. Duplicate
email is automatically skipped. If an email is already in the database, it is not archived.
However, if the mailbox has changed, or the email tags have changed, they will be updated in the
database.
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While the email is being archived, this window provides continuous feedback:

10

2015-06-26 18:26:57: Your certificate will expire in 30 days.

Stop

Clicking on the Stop button will stop the archiving operation and save all of the email in the
database that has been processed so far. It can take a litte while sometimes to finish processing,
so don't worry if it takes a little while for the Stop button to take effect.

When all of the email has been archived in the database, a window will appear showing some
stats about the email that has been archived. This information will also be logged in an archive
history file. You can view the archive history by choosing "Archive History" from the File menu.

Done Archiving Email

Processed: 4967
Archived: 4776
Duplicates: 191

View Log File e

Depending on the options chosen in the Settings window, MailSteward will store the text,
HTML, raw source, and, optionally, the attachments of your email. Once MailSteward is done
archiving the email, you can:

e Launch or save the attachments of individual emails.
e Add tags to email.

e Reply to an email.

e Forward an email.

e Print the email list.

e Print the individual selected email

e Print all the email in the list.

e Save the email list.

e Save the individual selected email.

e Save all the email in the list.

e Save the selected emails to PDF files.

e Save the raw source of the selected email.

e Save the raw source of all the email in the list.

e Save all attachments of selected emails to separate files.
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e Delete the selected email from the list.

e Delete the selected email from the database & the list.

o Delete all of the email in the list, from the database.

o Delete attachments of the selected email in the list, from the database.

e View the raw source of the selected email.

e Export email to a tab-delimited text file, a new MailSteward database file, an mbox file,
or an SQL file.

If an email has attachments or an HTML or enriched text version that has been saved in the
database, a list of the attachments will appear at the bottom of the email text as a blue, underlined
link beneath the title ATTACHMENTS:. Clicking on the link of an attachment will allow you to
launch the attachment using the appropriate application, or save the attachment as a file. If an
email has both plain text and HTML versions, the plain text will appear in the body text panel,
and the HTML version will be listed as an attachment below in the attachments panel. Clicking
on the link will cause the HTML version to be rendered and displayed in the body text panel,
instead of the plain text. The number of attachments for each email appears in the ATCH
column.

You can view the raw source of the selected email by clicking on the Raw button in the upper
right corner.

You can also Search for email in the database by any combination of date range, key words, and
tags.

=
Print ¥| Save Y| Delete ¥ | Export v & B hl=].4 Q | Q {.6:} S <s Renlv | Fwd & 00N Tag @ Raw

1 0
ID ATCH DATE TIME

17188 0 2015-06-26 12:18:00 Done Archiving Email ward.co
17094 0 2015-06-26 12:17:54 n@host:
17186 = 0  2015-06-26 12:11:10 Processed: 548 ward.co
17093 0  2015-06-26 12:11:06 3?;;‘:?;:71570 h@host:
17184 0 2015-06-26 12:09:26 ward.co
16978 0 2015-06-26 12:08:20 n@host:
17092 0 2015-06-26 12:05:33 View Log File OK n@host:
17089 0 2015-06-26 12:02:23 n@host:
17091 0 2015-06-26 12:02:04  nenw @aviy smenvug y[-swuuu:vw.\_.u"[ 2ave Mirie runs oy _g]vpm{uy\{‘ll\m‘\.Uvnr'ﬂ‘.hﬂﬂl;

“has tag 378 emails in this list. 17222 emails in the database. ”
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Search Email:
Once your email is in the database, it can be retrieved by specifying any combination of:

e arange of beginning and ending dates.

e keywords or phrases in the From address.

e keywords or phrases in the To address.

e keywords or phrases in the Subject line.

e keywords or phrases in the Body text.

e text strings in the Mailbox name.

e text strings in an attachment file name.

e text strings in attachment contents, if the attachment contains any text.
e text strings in the raw headings of the email.

e atext string anywhere in the email in any of the fields.

e tags - category, keywords, priority.

e Attachment types, such as graphics, documents, video, etc.

Or, if you know SQL, by editing the SQL statement generated by MailSteward.

If the only email with attachments check box is checked, then only email with attachments will
be retrieved. If an email has attachments or an HTML or enriched text version that has been
saved in the database, a list of the attachments will appear at the bottom of the email text as a
blue, underlined link beneath the tittle ATTACHMENTS:. Clicking on the link of an attachment
will allow you to launch the attachment using the default application for the type of file, or save
the attachment as a file. If an email has both plain text and HTML versions, the plain text will
appear in the body text panel, and the HTML version will be listed as an attachment below in the
attachments panel. Clicking on the link will cause the HTML version to be rendered and
displayed in the body text panel, instead of the plain text. The number of attachments for each
email appears in the ATCH column. The number of attachments for each email appears in the
ATCH column.

Binary attachments, like graphics, sound files, Word documents, or PDF files, are stored in their
original binary format. Any attachments that contain text, such as Word documents, can be
searched. However, the text in PDF documents is encoded such that it cannot be searched.
Clicking on the drop-down menu next to the Mailbox field will display a list of all the unique
Mailboxes in the database. Clicking on one of the mailboxes in the list will place it in the
Mailboxes search field.

Clicking on the Reset button will set all of the search criteria back to the default.

Once the search is done and the email has been retrieved, you can click on the header of any
column to sort in ascending or descending order.

If you click on the Search List button @ you can refine your search by doing a search within
the current search results list.
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If you click on the View raw source button |3 a separate window will open containing the raw
source of the selected email with all of the original header information.

Click on the Reply button, A to reply to the selected email. The OS X Mail application will be
launched and an email message window opened, with the From, To, and
Subjectinformation filled in, and the text of the message being replied to, inserted in the body.

Search Tags
| Today 7 Days This Month This Year
Beginning Date: Ending Date:
month day year month day year
04 [ |07 K3 2004 [ 10 3 | 31 g 2007 [

Quick Search Entire Message:

Database Fields Contain

AN = m & | jsmith
<) B | ismith
A [~ ubject 53
A [ ox 3 v
<] Body Text [ | contract
o B iy Text [ | proposal
v} ment Name |5}
OR BJAttachment Contents | ‘.’T()'\Yrr"l(:'.fj
AN k4  Attachment Types: choose attachment types to searct
Find only email with attachments oo
Edit SQL Statement Saved Soa:ches ? Cancel | Search |

Each of the field label drop-dow buttons can be changed to a different field label. So you can
search for multiple keywords or phrases in the same field. You can also drop down the buttons to
the left of the field labels to select AND, OR, AND NOT, or OR NOT.

The above search criteria will generate an SQL statement that will return all of the emails either
from or to Joe Smith that contain either the word "contract" or "proposal” in the body of the
email or the word "contract" in any attached documents. Also only emails with attachments will
be retrieved.
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If you click on the choose attachment types to search button, a sheet will appear where you can
choose attachment file types grouped as graphics, documents, sound, video, and/or compressed.
If you have tagged some of your email, you can do a search based on your tags, and you can also
combine the two and do a search that includes both fields and tags. Clicking on the drop-down
menu next to the Keywords field will display a list of all the unique Keywords in the database.

done retrieving email from /Volumes/Macintosh HD2/myemaildb

1076

107619

| Graphic Types - jpg, jpeg, png, gif, tiff, tif, ai, svg, webp, icns, ico, psd,

bmp, eps

Sound Types

swi, wmv

Compressec

Document T

Check the boxes of the desired attachment types [ Raw

Graphics Files
Document Files
Sound Files

4 Video Files
Compressed Files

eward.co

0

50 0
107620 0 These are the file extensions that will be searched 1/Sent M

0

L/INROX
I

ypes - doc, docx, rtf, txt, pdf, pages

s - wav, mp3, aac, aiff, aif, m4a, mp2, au, ogg, cga, rm

Video Types - mp4, mpg, webm, mov, moov, avi, mdy, fiv, mpeg, ogv,

i Types - zip, gzip, dmg, rar, tar, tgz

a Attachment Types: choose attachment types to search

Find only email with attachments

|
|
AND R Attschment Contents R

Edit SQL Statement Saved Searches ? Cancel Search

Reset

Clicking on one of the keywords in the list will place it in the Keywords search field.
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Clicking on the Saved Searches button brings up a window to let you save a set of Search
criteria, or execute a previously saved Search.

seach _[{jsmith contractsearc| |

SELECT email.id,date_fid,from_fld,to_fld,subj_fid,(CASE WHEN mailbox ISNULL
THEN " ELSE mailbox END),numAttach FROM email WHERE date_fld >=
"2004-04-00 00:00:00" AND date_fld <= "2007-10-14 23:59:59" AND (from_fld
LIKE "%jsmith%" OR to_fld LIKE "%jsmith%") AND (body_fid LIKE "%contract
%" OR body_fid LIKE "%proposal%") ORDER BY date_fld DESC

Set Browse Button Reset Browse Button

Search

If you click on Set Browse Button .the currently selected saved search will be made the default
for the Browse button. Whenever you click on the Browse button, this search will be executed
instead of listing all of the email in the database. If you click on Reset Browse Button, the
default for the Browse button will be reset back to listing all email. Clicking on the Edit SQL

Statement button will bring up the following window, which allows you to add parentheses or
NOTs, or enter your own SQL.

WHERE date_fld >= "2004-04-00 00:00:00" AND date_fld <= "2007-10-15 23:59:59"
AND (from_fid LIKE "“%jsmith%" OR to_fld LIKE “%jsmith%") AND (body_fid LIKE

'%c&:ntract%' OR attachText LIKE "%contract%") ORDER BY date_fld DESC LIMIT
100

Show Database Schema || Saved Searches

Search

Clicking on the Show Database Schema button will display a complete list of the tables and
field names in the MailSteward database structure.
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Browse Email:

Clicking on the Browse button [Jwill retrieve all of the email in the database, sorted by date. It
can then be sorted in any order by clicking on the column headers. By default the settings
limit the search and browse results to 1,000 emails, in order to speed up the process. However,
you can choose to not limit the results, or to limit them by some number other than 1,000.

Click on the Reply button <Ato reply to the selected email. The OS X Mail application will be
launched and an email message window opened, with the From, To, and Subject information
filled in, and the text of the message being replied to, inserted in the body. Clicking on the Fwd
button, %, will also launch the Mail app and open a new forwarded message window.

It is also possible to assign one of the saved Searches to the Browse button. For example, you
could specify a Search that begins in the current year, save the Search, and then assign that
Search to the Browse button so that when you browse you only see this year's emails rather than
all of the email in the database.

° e done retrieving email from /Users/jns/Desktop/junkdb

mm -@m-.

ATCH DATE TIME FROM SUBJECT MAILBOX
0 2015-06-26 11:11:02* pubblog <store@pL mmorders@pubblog New Crder Notification: ( mmorders@pubblog.com@host2( |
0 2015-06-26 09:57:23* pubblog <s(ore@pq. mmorders@pubblog New Order Notification: ( mmorders@pubblog com@host2( |

2015-06-25 16 11:58* pubblog <store@p. mmorders@pubblog New Order Notification: ¢ mmorders@pubblog. com@hostZ(
2015-06-25 09:52:37* pubblog <store@p. mmorders@pubblog New Order Notification: ( mmorders@pubblog.com@host2(
2015-06-24 15:33:40* pubblog <store@p. mmorders@pubblog New Order Notification: ( mmorders@pubblog.com@host2(
2015-06-24 13:53:41* pubblog <store@pL mmorders@pubblog New Order Notification: ( mmorders@pubblog.com@host2(
2015-06-24 11:24:47* pubblog <store@p. mmorders@pubblog New Order Notification: ¢ mmorders@pubblog.com@host2(
2015-06-24 11:22:47* pubblog <store@p. mmorders@pubblog New Order Notification: ¢ mmorders@pubblog.com@host2(
2015-06-24 11:14:09* pubblog <store@p. mmorders@pubblog New Order Notification: ( mmorders@pubblog.com@host2(
2015-06-24 05:25:33* pubblog <store@p. mmorders@pubblog New Order Notification: mmorders@pubblog com@host2(

~ N~ I - - I - I - - I -

1D: 17194

DATE: 2015-06-25 17:15:45

FROM: pubblog <store@pubblog.com>

TO: mmorders@pubblog.com

SUBJECT: New Order Notification: Order 27143

MAILBOX: mmorders@pubblog.com@host208.hostmonster.com/INBOX

Thank you for your order!
Please keep this order 1D for future reference.

YOUR ORDER ID NUMBER IS: 27143.

pubblog

707 N Spring St
Murfreesboro, TN 37130
6159484534

Order ID Number: 27143
Order Date: 06/25/15

BILL ADDRESS:
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You can also browse by email size and get a list of email sorted by the size of the individual
emails, in descending order, largest first. Finding and sorting email by size is somewhat slow, so
you may want to set a maximum limit on search results in the MailSteward General Settings.

New Database File... &N
Open Database File... #0
Open Recent b
Import mbox files... 31

Archive Email... 30
Search Email... #S
Browse Email... {+ 3B
Saved Searches... {r3S

Compact Database

Archive History
Duplicates Log
Database Statistics Report... 3R
Page Setup... 08P

Merge Database...
Check for Duplicate Email

Browse by Email Size... N
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Schedule Archiving:

MailSteward can be set to automatically schedule an archive of recent email. If you select the
Scheduling panel in the MailSteward Settings, you can specify a schedule for automatically
launching MailSteward to do an archive of new email. MailSteward should not be already
running. The scheduled instance will not launch if MailSteward is already running. The schedule
will launch MailSteward, archive all email starting on the most recent date in the database, and
then it will quit when it is done. In order for the scheduled archive to happen, the computer must
not be asleep. Make sure your Energy Saver System Preferences are set to never let the computer
sleep.

L N MO Scheduling

Remove Schedule Schedule

Save Settings

Archives can be scheduled either by days of the week, or by months and days of the month. They
can be scheduled for any specific time of day, or every so many hours. After setting the
scheduling options, clicking on the Schedule button will put an entry into your crontab file,
which will tell the operating system to run MailSteward at the specified time and dates.
MailSteward will then automatically archive email beginning on the date of the most recent
email in the database file. As always, any duplicates will be skipped. The scheduling options can
be changed at any time. Changing the options and clicking on the Schedule button will replace
the MailSteward entry in the crontab file. Don't forget to click on the Schedule button, and don't
schedule so frequently that a new instance of MailSteward is launched before the previous one
has finished.
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If the box to optionally leave a log file is checked, then a small text file with information about
the completed archive will be left in the same folder as the database file, making it easy to see
that the archive was done. If you don't want the log file to appear, uncheck this box.

Clicking on the Remove Schedule button will delete the existing MailSteward schedule from the
crontab.

The crontab is a standard UNIX facility for scheduling applications. An excellent utility for
viewing and updating the crontab is CronniX.
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Add, Search, & View Tags:

Clicking on the Tag button Qin the upper right corner will bring up the Add/View Tags
window (see below). If the currently selected email has a tag, there will be an asterisk next to
the date-time of that email in the DATE TIME column, and the tag for that email will appear in
the Add/View Tags window. You can then add a tag or edit an existing tag by entering your
choices and clicking on the Tag button. If multiple emails are selected, then they will all be
tagged. You can remove a tag, or set of tags, by clearing out the text boxes, setting the priority to
"None" and clicking on the Tag button. To see how searching with tags works, go to the Search
Email section.

mm orders

Tag

If you have been using the excellent MailTags © plug-in for the OS X Mail app, MailSteward
will automatically import your MailTags. If, during an Archive, a duplicate email is found, it is
skipped. In other words, tags on emails that are already in the MailSteward database will not be
replaced by imported MailTags.

If MailTags are imported, they will be translated into MailSteward tags. The MailTags Project
tag becomes the MailSteward Category tag. MailTags Keywords become MailSteward
keywords. MailTags Notes becomes MailSteward notes. And the MailTags Priority becomes the
MailSteward priority. The MailTags iCal To Do and Due Date tags are not imported.

You can also define rules to automatically tag email as it is archived, as explained in the Set
Rules for Tagging section.
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Set Rules for Tagging or Excluding:

Tags can be added to email in the database at any time, but it is also possible to define rules to
automatically tag email as it is archived into the database. You can also define a rule to exclude
email from being archived. Once a rule is defined, it is listed in the Tag Rules Settings and can
be enabled or disabled by checking the box next to it. By clicking on the right hand buttons you
can add a new rule, edit an existing rule, duplicate an existing rule, and remove an existing rule.

oO® O Tag Rules

L@ oo 9t 2

General Accounts Viewing Scheduling

Add Rule

mslite order
mspro order
10.xupgrade order
msupgrade order
msproupgrade orgef Remove
mssite order

Duplicate

msprosite order
filemyfiles order
wordwrapper order
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Clicking on the Add Rule, Edit, or Duplicate buttons will drop down a sheet for defining a rule

Description: | mailsteward order

If all g4 of the following conditions are met:

fron B contains K store
10 3 contains K4 mmorders
subject O] ontains k4 notification
body ) ontains C B
© Tag this email
Do not archive this emall
Tag thia email
Category: None €]

mm orders
Keywords: (separated by spaces)
maillsteward

Notes:

Priority: None [T

A rule may have up to four conditions. If the text box for a condition is left blank, that condition
is ignored. A rule can require all of the conditions to be met, or any one of them to be met,
depending on whether "all" or "any" is chosen in the top popup button. Once the conditions have
been set, you can choose to either tag email or exclude email from being archived, based on the
rule. If you choose to tag the email, the tag category, keywords, note, and priority can be
defined. Clicking on OK will add the rule to the list. As email is archived into the database, it is
checked against all active rules and tagged or excluded accordingly. As tag rules are checked,
tag keywords are added on separated by spaces. The other tags are replaced by subsequent rules.
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Back Up Your Database:

A MailSteward database is a single file like any other file. It can have any name and can be
located anywhere you choose. Since it is a single file like any other file, things can happen to it.
So, as with any important file, it is a good idea to maintain a backup. Because the file can
become quite large if you have a lot of email, you will probably want to exclude it from your
Time Machine backups. Otherwise the entire file will be copied by Time Machine every time it is
changed by archiving new email. Instead you can periodically make a copy of the file yourself so
that if your database file is ever damaged you can restore it from the backup.

TM & Copyright © 2004-2019 pubblog.com. All rights reserved.


http://www.pubblog.com/

MailSteward Manual Page 24

Export a Tab or Comma Delimited Text File, a MailSteward Database File, an
Mbox File, an SQL File, or a list of email addresses:

Any list of stored or retrieved email can be exported to a tab or comma delimited text file, or to a
new MailSteward database file, or to an "mbox" format file that can then be imported into most
email clients, or to an SQL file that can be imported into a MySQL database. Or a list of all the
From, To, or both email addresses can be exported. Just click on the Export drop-down button
and select the desired export format. A tab or comma delimited text file can then be imported into
FileMaker or Benton or other database and spreadsheet applications. A MailSteward database file
can then be accessed by MailSteward by specifying it in the MailSteward Settings. An mbox file
can then be imported back into OS X Mail or Microsoft Entourage or other email clients, or
MailSteward itself. An SQL file can be imported into MySQL. If the tab or comma delimited text
file option is chosen, attachments and tags are not exported. Only the plain text portion of the
email is exported. If the MailSteward database file option or the SQL option is chosen, then
everything will be exported, including any attachments and tags and copies of the email raw
source. In the case of the mbox format, everything will be exported except for the mailbox and
tags. The standard mbox email format does not include the concepts of tags or mailboxes.

A YAl—I e (+) SR,
Exportyll L/ |C= | M | A | WS
ety
tab-delimited text... SL
00 comma-delimited text... Congratu
54 MailSteward database file... Congratu
10 mbox file... Champiot
06 sqL file... Champiot
26 . . Eat carbs
list of email addresses...
20 ) Do NOT e

- - - -

L Nnlina FNIT #Nnling inc@niihhlan ram Inin Tha }

Binary attachments are stored in the original binary format in MailSteward. The SQL generated
by MailSteward will also cause the binary attachments to be stored in MySQL as binary blobs.

Here are the SQL statements used to create the MySQL database and the email and attachments
and origemail and tags tables:

CREATE DATABASE IF NOT EXISTS [database name];
USE [database name];

CREATE TABLE IF NOT EXISTS email (id INTEGER PRIMARY KEY NOT NULL
AUTO_INCREMENT.,from_fld VARCHAR(255) NOT NULL DEFAULT ",to_fld
MEDIUMTEXT NOT NULL,subj_fld MEDIUMTEXT NOT NULL date_fld datetime NOT
NULL ,mailbox varchar(127) NOT NULL DEFAULT " ,mailto varchar(127) NOT NULL
DEFAULT ",body_fld LONGTEXT NOT NULL,numAttach INTEGER NOT NULL DEFAULT
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0,attachNames mediumtext NOT NULL ,attachText mediumtext NOT NULL headings
MEDIUMTEXT NOT NULL,INDEX datelndex (date_fld));

CREATE TABLE IF NOT EXISTS attachments (id INT NOT NULL ,type_fld varchar(127) NOT
NULL DEFAULT " filename_fld varchar(127) NOT NULL DEFAULT ",encode_fld INT default
0,attach_fld LONGBLOB NOT NULL,INDEX idIndex (id));

CREATE TABLE IF NOT EXISTS origemail (id INTEGER PRIMARY KEY,orig_fld
LONGBLOB NOT NULL);

CREATE TABLE IF NOT EXISTS tags (id INTEGER PRIMARY KEY.cat_fld varchar(127)

NOT NULL DEFAULT " key_fld varchar(127) NOT NULL DEFAULT " priority_fld INT
DEFAULT 0,notes_fld mediumtext NOT NULL);
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Import mbox Files...:

New Database File... N
Open Database File... #$0
Open Recent B
Import mbox files... N 1

Archive Email... {+30
Search Email... #8S
Browse Email... {+3¥B
Saved Searches... {+3S
Compact Database

Archive History
Duplicates Log
Database Statistics Report... 3R
Page Setup... 038P

Merge Database...
Check for Duplicate Email
Browse by Email Size...
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The Microsoft Entourage X email client uses a
proprietary database to store email. However if you
drag a mailbox from Entourage onto your desktop or
into a folder, Entourage will export the dragged
mailbox as a standard format UNIX mbox file that
MailSteward can understand. Entourage only converts
the email at the top level of any folder that you drag. It
doesn't convert any email contained in subfolders.
Each subfolder has to be dragged individually. Most
other email clients also can export mbox files. Mbox
files that have been created in this way can be read into
your MailSteward email archive by selecting Import
mbox files... from the File menu. Also, in the
MailSteward Settings, you can specify a folder that
contains mbox files, that you want to be imported
whenever you do an Archive.

To export email from Outlook 2011 in a format that
can be imported into MailSteward, perform an Edit ->
Select All in the folder or Inbox you wish to Export.
Click & hold the mouse until you see the number

count come up on the cursor. Then move the cursor over a Finder folder window and release the
mouse. Wait while Outlook locks up & churns from exporting the emails. There will be no
progress bar. This will fill the folder with .eml files of all the emails. The .eml files can then be
imported into MailSteward by selecting Import mbox files... from the File menu.

Eudora mailboxes are also in an mbox format that can be imported into MailSteward. Eudora
mailboxes are usually found in the ~/Documents/Eudora Folder/Mail Folder directory. If you are
importing a Eudora mailbox, do not move or copy it to a different directory. MailSteward
depends on the Eudora folder hierarchy to correctly process Eudora email files.

There is a problem with Eudora email attachments. Eudora removes the attachments from the
email and stores them in a separate folder and puts a reference to them into the mbox file that it
generates. The reference to the attachment does not say where the attachment is located. Its
location is something known to Eudora, but is not defined in the mbox file itself. With a simple
default Eudora folder hierarchy, MailSteward will find the attachments, but with a more
complicated folder hierarchy, sometimes MailSteward is unable to find the attachments. The mail
will be successfully imported, but the links to the attachments will not always be viable.
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Check for Duplicate Email:

New Database File...
Open Database File...
Open Recent

Import mbox files...

Archive Email...
Search Email...
Browse Email...
Saved Searches...
Compact Database

Archive History

Duplicates Log

Database Statistics Report...
Page Setup...

Merge Database...

Check for Duplicate Email N

Browse by Email Size...

.

N
#0

a6l

360

#S
{38
+36S

#R
03P
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As email is archived into the database, MailSteward will automatically skip duplicates. An email
is considered a duplicate if there is an exact match on the From, To, Date and Time, and the first
500 characters of the body, with an email that is already in the database. This will work most of

the time, but sometimes a duplicate email will get through. It is also possible that some
duplicates may have gotten into the database because of changes in previous versions of

MailSteward. Duplicate emails that are skipped during an archive are logged in the Duplicates

Log. Click on Duplicates Log in the File menu to view the list of logged duplicates.

You can check for duplicates in the database by clicking on the Check for Duplicate Email item
in the File menu. MailSteward will then go through the entire database and look for email that
has an exact match on the From, To, Date, minutes, seconds, and Subject. It does not match on
the hour in case some email was archived in different time zones, and it does not match on the

body, but it does look for a match on the subject.

The duplicate email will then be listed in the Browser window where it can be examined and

deleted.
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Database Statistics Report:

Clicking on the Database Statistics Report... item in the File menu will bring up the following
Settings window. Clicking on Create Report will produce a report like the one below.

Create Report...

From 2005-01-01 thru 2009-02-23

Total Number of emails in date range: 10,107

Number of emails with attachments: 1,325
Number of emails with tags: 2,511
Number of mailboxes: 42

By Year:

2005: 5,020
2006: 5,087

Top Twenty Senders:

1,164 RegNow Order Server <automated@regnow.com>
848 john seward <jns@pubblog.com>
797 MailSteward <mailstew@mailsteward.com>

Top Twenty Recipients:

1,164 orders@mailsteward.com <orders@mailsteward.com>
942 jns@pubblog.com
654 nickseward@mac.com
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By Mailbox:

2,284 mailstew@mailsteward.com@mail . .mailsteward.com/
INBOX

2,024 jns@pubblog.com@mail.pubblog.com/INBOX

1,875 Mac-nickseward/INBOX
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Merge Database Files:

Clicking on the Merge Database... item in the File menu brings up a standard Open dialog to
choose a MailSteward database file that you want to merge with the current database file. This
can be useful if, for example, you have one database file on your desktop computer and a
different one on your laptop. You can periodically merge the laptop data into your desktop
database file. If there are duplicates, the email in the current database file is retained, rather than
being replaced by the database being merged into the current database. However, if the email in
the current database does not have a raw source or tags, and the email in the database to be
merged does have either or both, then they will be added to the database.

@® Choose Database File to Merge

3 = [njlog: Macintosh HD2 > Q
Favorites Name Date Modified v Size
@ Recents ! myemaildb Today, 1:46 PM 14.16 GB
A. Applicati > video 2/21/15, 5:36 PM -

o ications

Bk ? Install OS X Yosemite.app 1/15/15, 3:33 PM 5.17 GB
& All My Files » pictures 4/20/14, 6:22 PM =

7 iCloud Drive ¥ audio 3/23/13, 4:48 PM

lightroom pictures 1/12/13, 1:40 PM

[ Desktop
&# Dropbox
M Documents
0 Downloads
B Movies

-1 Music
Pictures
Q jns

= projects

|~ S P |

cancel | (N
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Compact Database:

New Database File... 3N
Open Database File... #0
Open Recent >
Import mbox files... a8l

Archive Email... {+380
Search Email... #S
Browse Email... 3B
Saved Searches... - 3S

Compact Database N

Archive History
Duplicates Log
Database Statistics Report... 3R
Page Setup... ¢ 3#P

Merge Database...
Check for Duplicate Email
Browse by Email Size...

As email is archived and then deleted, empty records are created in the database. This doesn't
hurt anything, but it does make the database file larger than it needs to be. The empty space can
be reclaimed by selecting Compact Database from the File menu. This will remove all of the
empty records and compact the database. The compactind is done in place, so you should always
make a backup copy of the database file before compacting the database.

Another,somewhat safer way of compacting the database is to do a Browse, listing all of the
email in the database, and then export it as a new MailSteward database file.
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System Requirements:

The system requirements are simple. You have to have a Macintosh running OS X 10.8 or greater
(Mountain Lion, Mavericks, or Yosemite), and you have to be either using the Mac OS X Mail
application that came with your computer or the Postbox email application, in which case
MailSteward will automatically list all of your email accounts or mailboxes in the Settings
dialog.

Or, if you are using Microsoft Entourage X, then you will need to drag your Entourage
mailboxes onto your desktop or into a folder, and import the resulting mbox files into
MailSteward by selecting the Import mbox files... item from MailSteward's File menu. Other
email clients also have the ability to export mbox files. MailSteward supports POP, .Mac, and
IMAP email accounts that are stored locally on your computer. The free version of MailSteward
has full functionality, but is limited to a capacity of 15,000 emails.
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